Using Microsoft Word Mail Merge

'W| Using Microsoft Word

Mail Merge

Mail Merge if a feature that has become common in Word Processing applications.
It allows duplicate copies of a document to be created with each copy being
customised in certain ways. For example, the diagram below shows different
copies of the same letter that have used a Mail Merge to place each letter
recipient’s name at the top.

This can be very useful for documents like letters, envelopes and mailing labels. For example, if you
had a letter to send out to 50 customers, you could create one copy of the letter and then use Mail
Merge to place each customer’s name and other relevant details in the right places. This allows you
to make each copy of the letter more personalised without the need for creating each copy from
scratch.

There are several things you need to do in order to do a mail merge, which don’t necessarily have to
be done in this exact order.

Decide what type of merge you will do (letter, mailing labels etc).
Create the document that will be used for the merge.
Create/open the data source that will be used to provide the personalised details for each copy.

Insert data fields in to the document where the personalised details and other variable details
(such as the current date) can go.

Perform the merge to create the copies of the document.

Note In different versions of Word there are variations in the way Mail Merges are done. The

procedure changed quite a bit when Word 2002 (XP) was introduced. These exercises
show the process using Word 2003 which hasn’t changed much from the 2002 version,
though some screens may look slightly different.
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Exercise 1. Creating the Document
1) Create a new blank Word document.

2) Type the following document exactly as it appears with blank lines where indicated (correct any
errors that appear).

<blank line>
<blank line>
<blank line>
<blank line>
Deawr

<blank line>

As o valued customer, we could like to- take this opportunity to- thank-yow for
shopping withv Nutty Net , the Internety leading online peanut sellers. We
would also- like to- let yow know that we are moving to-a new, bigger location
i Pertivs Central Busines District. Owr new premises will allow us to- stock v
greater variety of peanuity so-that theve will be move for yow to-choose from.

The move will take place at the end of Jawnuawy. After that time; yow will stillh
be able to- order from owr websit as normal , but postal ovders will need to-go-
to-owwr new address. The new address will be :

49a Walnut Lane
tast Pertiv
Western Australov
6004

Owr website and our email address owe stil;
www. ttynet.com.aw
pearuls@ nuttynet. com.ounv

Feel free to- visit owr website and browse through owr catalog to- see the new
aditiony that the new larger premise wil allow us to- add to- owr range of
peanuts. We look forward to- continuing to- serve your nutty needs:

The Manager
Nutty Net
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Exercise 2. Manually Inserting a Field

1) Save the document you just created as Mail Merge Letter.
2) Click in the first blank line of the document.

3) From the Insert menu select Field.

QO e 00®
Please choose a field ——  Field properies ————— Fieldoptions ——————
Categories: Cate formats:
| (Al @ |dddd. dd MMMM yyyy [[] Use the HijrifLunar calendar

2 02/02/2005 i
Field names! \Wednesday, 09 February | || Insert the date in last used format
AutoMumLgl [a] 0% February 2005 from Insert menu
AutoMumOut 09/02/05 [ Use the Saka Era calendar
AutoText El 2005-02-09
AutoTextlist ‘ = | 9-Feb-05
BarCode - | 09.02.2005
BidiQutline 09 Feb, 05
Comments 9 February 2005
Compare February 05
CreateDate Feb-05
Database 09/02/2005 12:44
09,/02/2005 12:44: 14
DocProperty 12:44 PM
Docvariable 12:44:14 PM
EditTime 12:44
Eg [s] 12:44:14
Description:
Today's date
[+] Preserve formatting during updates
Field Codes 0K Cancel
| [ Fesces | yox I )

4) From the Field names list on the left choose Date.
5) From the list of Date formats in the middle choose a long date format like the one shown above.

6) Click OK when done. A date will be inserted as a field much like the fields that are used for table
calculations. Since it is a field is will always stay current so the current date will always be
displayed at the top of the letter.

Wednesday, 09 February 2003

Dear

As avalued customer, we could like to take this opportunitv to thank-vou for shopping
with Nuttv Net, the Intemets leading online peanut sellers. We would also like to let vou
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Exercise 3. Beginning a Mail Merge brotectuacument. .
Online Collaboration »
1) From the Tools menu select Letters and Mailings [ tters o Maiings T e &
and then SEIeCt Mall Merge' Macro » Show Mail Merge Toolbar
2) The Mail Merge Task Pane will appear on the ) o M =1 Envelopes and Labels...
. - - z#  AutoCorrect Options... Letter Wizard...
side of your screen like in the example below. —_— -
This presents a step by step way of creating a ostons...
mail merge.
3-1-2-|-1-|-é-|-1-|-2-|-2-|-4-|-E-|-5-|-_T-|-5-|-5-|-1:--|-11-|-12-|-12-T Mail Merge v ¥
@ fat
Select document type
What type of document are you working on?
(*) Letters
() E-mail messages
Wednesdav, 09 Februarv 2003 () Envelopes
O Labels
(O Directory
Letters
Dear v
Send letters to a group of people. You can
personalize the letter that each person
As a valued customer, we could like to take this opportunity to thank-vou for | receives.
with Nutty Net, the Intemets leading online peanut sellers. We would also like Click Next to continue.

know that we are moving to a new, bigger location in Perth’s Central Busines:
Qur new premises will allow us to stock a greater varietv of peanuts so that th
more for vou to choose from.

The move will take place at the end of Januarv. After that time, vou will still b
order from our website as normal, but postal orders will need to go to our new
The new address will be:

49a Walnut Lane

East Perth

Western Australia

6004

Our website and our email address are still: Step 1of6
TWWOW NULTvIet coml au

Peanuts @nuttvnet com au

 Mext: Starting document

oW

3) In the task pane, make sure Letters is selected under document type.

4) At the bottom of the task pane you will see Step 1 of 6. Click on the Next: Starting document link
that is below that to move to the next step in the process.

The next step asks if you want to use the currently open document, create a  Sciect starting document
How do you want to set up your letters?

new document from one of the built in templates or open an existing & use the current document
docu ment. (O start from a template

(O start from existing document

5) Make sure the Use the current document option is selected and click on
Next: Select recipients.

In the third step, you need to specify where the date for the mail merge Select recipients _
will come from. In this case the data will contain the personal e e
information that will go on each copy of the letter. You can use a list that
you have already created, you can have the information taken from your . ot

Microsoft Outlook contacts list or you can create a new list. Use names and addresses from a fle or 2

database.

(O Select from Outlook cantacts

(O Type a new list

@ Browse...
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6) Select the Type a new list option. You will now see a Create option Typea new list

R Type th d add f recipients,
underneath as shown to the right. e ———
=] Create...

7) Click on Create. A New Address List screen will appear which allows you to enter details in to a
new list.

&
Title || |

First Mame | |

Last Name | |

Company MName

Address Line 1

Address Line 2 | |
city | |
e | ] ’Zl |
[ Mew Entry ] [ Delete Entry ] [ Eind Entry... ] [Filter and §0rt...] [ Customize. .. ]
_ View Entries
View Entry Number I:I
Total entries in list 1

Cancel

8) You may want to customise the available fields to suit your own information better. Click the
Customize button. A list of the existing fields will appear.

Field Names
——
First Mame =
Company Mame Delete
Address Line 1
Address Line 2 Rename
City
State
ZIP Code
Country [%
Home Phone
Work Phone
E-mail Address

[ QK ] [ Cancel ]

Change field name

From: ZIP Code

To |Post|C0de |

(o i) (o)

10) Change ZIP Code to Post Code and click OK.
11) Repeat the above steps to change City to Suburb.
12) Click OK to return the New Address List window.
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Using Microsoft Word
13) Enter the following details.

First Name Richard
Last Name Ashton
Address 302 Coode St
Suburb Dianella
State WA
Postcode 6059
Country Australia

Mail Merge

14) When all of this information has been entered, click New Entry to clear the form ready for another

addition to the list.

15) Continue until each of the following people has been added to the list.

First Last Company Name State|Country |Post Address Suburb
Name Name Code
Richard |Ashton WA |Australia |6059 302 Coode St Dianella
Anne Cambridge WA |Australia {6060 83 Wordsworth Yokine
Ave
Nuts and Bolts WA |Australia (6010 340 Stirling Claremont
Hardware Highway
Robert  [Smith Bob's Building Co. WA |Australia 6237 RMB 175 Stratham
Minninup
Amy Clayton New 22 Taupiri St Te Kuiti
Zealand
David Armstrong WA |Australia (6432 10 Minchin Mews |Kalgoorlie
Cyber Sandwiches WA |Australia 6003 111 James St Northbridge
Internet Cafe
Judith Court VIC |Australia |3030 32 May Ave Chartwell
Peanut Butter Perfection |WI |[USA 54915 |W6072 Blazing Appleton
Star Dr
Adrian Everett WA |Australia |6069 18 Angophora Ave |Ellenbrook
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Mail Merge

16) After you have entered the last of the addresses, click the Close button. You will be prompted to
save the data file (which will save the details in a Microsoft Access file format).

008

Save in: |uj Exercises EI @ =] Q, ™ REE

Tools

My Recent
Documents

Desktop

My Documents

My Computer

Flename: [Nutty Addresses

My Metwork
Flaces Save as type: |Microsof't Office Address Lists {*.mdb)

B (e )

@ Cancel !

17) For the filename enter Nutty Addresses and choose the same location as your other files. Click

Save when ready.

18) You will now have a screen which allows you to review, edit or omit names in the list. Click Ok
to close this list and return to the Mail Merge steps.

Q@ airege Reapents ————————————————_JOIOIO)

To sort the list, dlick the appropriate column heading. To narrow down the recipients displayed by a
specific criteria, such as by city, click the arrow next to the column heading. Use the check boxes or

buttons to add or remove recipients from the mail merge.
List of recipients:

Cambridge Anne

Muts and Bolts hard...
Smith Robert Bob's Building Co
Clayton Amy
Armstrong David

Cyber Sandwiches i...
Court Juduth

Peanut Butter Perfe...

HEREEREREEE

Ewerett Adrian

A

¥l LastNa... ¥ FrstMa... s P ¥ Company Ma... ™| Address Lin
_iﬁﬂ_mﬂ-_d Coode 5t

83 Wordsworth A
340 Stirling Highw
RME 175 Minninug
22 Taupiri 5t

10 Minchin Mews
111 James St

32 May Ave
Wa072 Blazing 5t
18 Angophora Av|

[2]

Select Al ][ Clear all ][ Refresh ]

[
[ Eird... ][ Edit... ][ Validate ]

|

19) Click Next: Write your letter to move to the next step.

Step3of 6
% MNext: Write your letter

Since our letter has already been written, we only need to add in the merge =~ ® Prevess: strine domment

fields.
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Mail Merge

In older versions of Word, something like an address would have been added one field at a time like
in the example below. In current versions it is still possible to select fields one by one but there are
easier ways. Some preset collections of fields are available from the task pane on the right.

Fridav, 11 Februarv 2003

«Address Line 1w

«Countrvs

Dea.rl

wFirst Wame» «Last_Names

wSuburbsaStaten«Po St_C odes

To add recipient information to your letter,
dick a location in the document, and then
dick one of the items below.

= Address black...

3 Greeting line...

_f| Electronic postage. ..
=] Mare iteme. ..

20) Click on the blank line between the date and the Dear line. This is where we will place the

address for each person.

21) From the task pane on the right, click on Address Block.

Co
9

'©/C Tnsert Address Blod

Specify address elements

Insert recipient's name in this format:

Joshua

Joshua Randall Ir.
Joshua Q. Randall Ir.
Mr. Josh Randall Ir,

Mr, Josh Q. Randall Jr.
Mr. Joshua Randal Jr.

Insert company name

Insert postal address:
(3 Mever indude the countryregion in the address
() Always include the country/region in the address
(# Only indude the countryfregion if different than:

BiE

|Australia

(el

Format address according to the destination countryfregion

Preview

Blue Sky Airlines,

Mr. Joshua Randall Ir.

1 Airport Way

Kitty Hawk NC 27700
United States of America

=N

The top section allows you to choose how the person’s name will appear in the address block and
whether or not you will include company name (if the address includes one). There is also an option
to only include the country in the address is if it an overseas address. One of the great things about
the address block feature is that it doesn’t leave blank lines for fields that are blank. Everything is
kept together nice and neatly. One problem is that if you have customised the fields in the earlier step
then Word may not recognise them to include them in an address block.

22) Click the Match Fields button.
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Mail Merge

QQMatchields @ISO
Mail Merge has spedial features for easily working with addresses., Use the drop-down list
to select the proper database field for each address field compaonent.

Required information s
Last Name Last Name -
First Mame First Mame ol [
Courtesy Title Title =i [
Company Company Mame =
Address 1 AddressLine 1
City Suburb -
State State -
Paostal Code %
Spouse First Name Title E‘
Optional information First Mame
Middle Name Last MName E‘
o1 Company Mame 1
Use the drop-down lists to choose the field from your database Address Line 1 the
address information Mail Merge expects {listed on the left.) Address Ling 2
Suburb
State @
X Post Code

23) You may find that fields

4

you have renamed such as Post Code and Suburb may not be matched
up to any address component. Use the drop down lists to make sure that Suburb is matched up
with City (on the left) and Post Code is matched up with Postal Code.

24) Click OK when done and then click OK again to complete the address block.

25) Delete the word Dear. We will put an automatic greeting line including the recipient’s name in

its place..

26) In the task pane on the right, click Greeting Line.

PRSI (O O )
Greeting line format:

Dear | @l |Mr. Randall |ZI

Greeting line for invalid recipient names:

|Dear Sir or Madam, |2

Preview

Dear Mr, Randal, ‘

(=5 Cre ) Com )

27) Check that the format for the greeting line is suitable (maybe view some of the different options)
and click OK to insert the greeting line. The completed letter should show fields like in the

example below.

«QreetingLines

1 P

Fridav, 11 Februarv 2003

wAddressBlocks

As a valued customer, we could like to take this opportunity to thank-vou for
with Nuttv Net, the Intemets leading online peanut sellers. We would also like

- h 1 P S i IS,

Pl seael T
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28) Now let’s see if it all works. Click on Next: Preview your letters to move on to step 5. The fields on
your letter will now be replaced with details from one of your addresses.

Fridav, 11 February 2003
Cvber Sandwiches intemnet Cafe,

111 James St
Northbridge WA 6003

Dear Sir or Madam,

As a valued customer, we could like to take this opportunitv to thank-vou foi
with Nutty Net, the Intemets leading online peanut sellers. We would also liK

Preview your letters

29) Click the Previous << and Next >> buttons in the Task Pane to view One of the merged letiers s previewed here.
To preview another letter, click one of the

the different addresses in the letter. bl

If you wanted to print one copy of the letter for a specific person, you C] e )
could simply select the right address and then print while that address B Fnd > recpient.
was showing.

30) Save the document and leave it open.

Note when you have created a mail merge document, the mail merge toolbar will often appear
(as shown below). In the middle of that toolbar are buttons for moving through the different
address records. You can also type the number of a record (record number 8 in the list for
example) and then press [Enter] to move straight to it.

AE & | 2 B B | nsertwordField~ j R H 4 w0 PG R By By =
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Exercise 4. Completing the Merge

Step 5of 6

1) Make sure the Mail Merge task pane is still showing on the right side of the
screen. If it isn’t, go to the Tools menu and select Letters and Mailings = Mail
Merge.

& Next: Complete the merge

4 Previous: Write your letter

2) From the task pane click on Next: Complete the merge. Complete the merge

Mail Merge is ready to produce your letters,

The task pane will now show two options. The first option will print  ro personsiee your etters, cick ‘it
copies of the letter for each address in the address list you created. The  fenent s e neges bre. o make
second option will create a new document with each copy of the letter — sard gesmene o oo
beginning on a new page so you can edit/review them before printing. rerge

Similar options are also available on the Mail Merge toolbar if it is 23 Print..

ShOW'ng .,_] Edit individual letters. ..
3) Click the second option, Edit individual letters.

©/@ Terge to iew D._ OIS

) Current record

O Erom:| | To: | |

[ ok ][ cancel ]

‘.

4) The Merge to New Document dialog will allow you to specify which records will be included in the
new document. Leave the All option selected and click OK.

5) A new document with a copy of the letter for each person will be created. Scroll through the
document to review each copy of the letter.

6) Save the document as Merged Letters and then close it.
7) Save and close the original Mail Merge Letter document.

Note You can use mail merge to quickly print addresses on mailing labels. Sheets of labels in
standard sizes can be bought from most news agents and stationery stores and are
supported in Microsoft Word. If you have a printer that can print on envelopes you can also
use mail merge to print addresses directly on the envelopes for a professional look.
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